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IBM Trusteer Rapport – Solution Update 
Over the last year, we released extensions for Google Chrome, Mozilla Firefox for Windows and Mac 
computers, and in September 2018, an extension for Microsoft Edge for Windows 10 computers. We 
are pleased to announce that we are now releasing an update to Rapport that provides  extensions 
for Safari Version 12 and later, on computers with Mac OS X High Sierra and later.  

What is changing? 

In addition to providing extensions for Firefox, Chrome, and Edge, Rapport will also use browser 
extensions in Safari to provide the browser protection layers on computers with Mac OS X High Sierra  
and later. 

This solution will start a gradual release from February 28, 2019. 

Why use extensions? 

In the past, there was often an update required for Rapport to support each new browser version. It 
could take weeks from the release date of the browser before this update was ready to deploy. In 
most cases using an extension-based architecture eliminates the need for a Rapport update. 

There are several other reasons why Rapport now uses an extension-based architecture: 

 They are supported by most web browsers. 

 Browser manufacturers are committed to backwards compatibility. 

 An extension allows IBM to: 

 Extend protection layers to existing web apps 

 Provide user notifications and alerts 

 Provide links and information on web pages 

 Allow a quick install that is available in web\app stores 
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Safari Extensions 

Information for Existing Rapport Users 

Users that already have Rapport installed must upgrade their current installation to Rapport Version 
1945. The upgrade is completed automatically when they receive and apply the code update. The 
extensions are supported only on Rapport Version 1945 and later.   

For detailed information about installing Rapport, see 
https://www.ibm.com/support/knowledgecenter/SS7MJT_1930/ug/t_Installing_Rapport_on_Mac.html 

Note: The extensions are available only for Safari Version 12 or later on Mac OS X High Sierra or 
later.  

Once Rapport Version 1945 is installed, users must only enable the extensions the first time they 
start Safari. 

As with past releases, it is highly recommended to install Rapport from an administrator account, 
since it automatically extends Rapport protection to all users. 

How do I Install the Extensions? 

The extensions are added automatically during the Rapport 1945 installation or upgrade. The 
product includes two Safari Extensions which must be enabled as described in the following section. 

How to Enable the Extensions 

1. Open Safari and in the Mac Menu bar select Preferences and Extensions. The Extensions 
page opens. 

https://www.ibm.com/support/knowledgecenter/SS7MJT_1930/ug/t_Installing_Rapport_on_Mac.html
https://www.ibm.com/support/knowledgecenter/SS7MJT_1930/ug/t_Installing_Rapport_on_Mac.html
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2. On the Extensions page, select Rapport Extension and Rapport Content Blocker.  
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3. Close the preferences menu.  

4. When the extensions are successfully enabled, your navigation is protected. The shield icon, 
which is visible on the left side of the address bar, indicates that the site is protected. 

 
If there are problems with the extensions and navigation to sites is unprotected, the shield icon will 
show an “x” inside.  

  
Troubleshooting 

What Happens if the Extensions are Disabled? 

If the end user does not enable the extensions, the following occurs when they try and navigate to 
the online banking site: 

 If you are a Mandatory Rapport customer, end users will only be allowed to access your 
online banking site if the Safari extension is enabled. If it is disabled, they will receive the 
splash screen. 

 Non-mandatory users will be able to access the online banking site, but with limited 
protection, i.e. general computer protection is active, but browser level protection is not. 
Users may see the splash screen depending on your configuration. 

What Happens if the Safari Extensions are not Visible in the Extensions Tab? 

If you do not see the Safari extensions in the Extensions tab, you should restart your computer. If the 
problem persists, perform a clean installation of Rapport Version 1945 and repeat the enablement 
steps described in the previous sections. 
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What Happens if the Safari Extensions are enabled, but the Shield icon is not 
Visible in the Address Bar?  

If you have enabled the extensions but do not see the shield icon when you navigate to a protected 
site, you might need to customize the Safari tool bar. From your browser, select View > Customize 
Toolbar and add the Rapport shield icons by dragging them into the toolbar. 
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Microsoft Edge Extension 

Information for Existing Rapport Users 

Users that already have Rapport installed do not need to reinstall it. 

However, they must install the extension from the Microsoft Store the next time that they start Edge. 
Users who had already enabled the extension from a previous Rapport version are not required to do 
anything. 

Note: The extension is available only for Microsoft Edge version 16 or later on Windows 10 
computers. 

As with past releases, it is highly recommended to install Rapport from an administrator account, 
since it automatically extends Rapport protection to all users. 

How do I Install the Extension? 

Rapport must be installed before you can install and use the Rapport extension. 

1. When you open the Edge browser after the installation of Rapport, the following popup 
appears prompting you to install the Rapport Edge extension. 

 

2. To proceed with the installation, click Install Extension  

The Microsoft Store opens. 
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3. Click Get. 

The extension is downloaded and installed. 

4. When the installation is complete, the Microsoft Store shows a Launch button. 

 
5. Click Launch. 

Microsoft Edge opens and a popup appears offering you the option to turn on the extension. 
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6. Click Turn it on. 

The Rapport Edge extension is now enabled. When navigating to a protected site, the end 
user will see the green Rapport icon in the address bar: 

 

For detailed information about installing and enabling the Edge extension, watch the video at this 
link: https://vimeo.com/281276666/b1365a2222. 

https://vimeo.com/281276666/b1365a2222
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Troubleshooting 

What Happens if the Extension is Disabled? 

If the end user does not enable the extension, the following occurs when they try and navigate to the 
online banking site: 

 If you are Mandatory Rapport customer, end users will only be allowed to access your online 
banking site if the Edge extension is enabled. If it is disabled, they will receive the splash 
screen. 

 Non-mandatory users will be able to access the online banking site, but with limited 
protection, i.e. general computer protection is active, but browser level protection is not. 
Users may see the splash screen depending on your configuration. 

Note: The protection status can always be determined by the Rapport icon. If it is green, it is 
providing protection. If it is gray, it is enabled, but the user is not on a protected site. 

How to Enable the Extension 

If the end user did not click Turn it on when installing Rapport, or the extension is disabled, the 
extension can be enabled at any time with the following procedure. 

1. Open Edge. 

2. Click the menu button, and then click Extensions. 

The Extensions pane appears. 

3. Move the slider to On. 
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The Rapport icon is colored green when navigating to your banking site to indicate that the site is 
protected. The end user can go to the banking site to make sure that it works. 

What Happens if the Rapport Icon is colored Purple? 

If the extension is enabled but for some reason it has lost communication with Rapport, when you 
navigate to the online banking site the Rapport icon in the address bar is colored purple: 

 

The purple icon indicates that navigation protection is limited. In this situation, when the user 
navigates to a blacklisted site, an alert pop-up message is displayed indicating that a potential 
phishing site was accessed. The purple icon represents an unusual behavior that might occur when 
Rapport is not running or was not installed correctly. The user should check that Rapport is installed 
and running, or contact Support for further investigation. When communication between Rapport and 
the extension is reestablished, the normal behavior is restored and the Rapport icon is colored green 
when navigating to the banking site. 
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Google Chrome Extension 

Information for Existing Rapport Users 

Users that already have Rapport installed do not need to reinstall it. 

However, they need to enable the extension the next time that they start Chrome. Users who already 
enabled the extension from a previous Rapport version are not required to do anything. 

As with past releases, it is highly recommended to install Rapport from an administrator account, 
since it automatically extends Rapport protection to all users. 

How do I Install the Extension? 

Rapport must be installed before you can use the Rapport extension. For more information about 
installing Rapport on Mac and Windows, see: 

 Mac: 
https://www.ibm.com/support/knowledgecenter/SS7MJT_1930/ug/t_Installing_Rapport_on_Ma
c.html 

 Windows: 
https://www.ibm.com/support/knowledgecenter/SS7MJT_1930/ug/c_Installing_Rapport.html 

To help you better understand how to use the new Rapport extension we created several videos on 
the following page: https://www.trusteer.com/support/chrome-extension 

The extension will be automatically installed as part of the Rapport installation. After Rapport 
installation, the next time end users start Chrome, they need to do the following: 

1. On the Enable extension dialog, the end user must click Enable extension. 

https://www.ibm.com/support/knowledgecenter/SS7MJT_1930/ug/t_Installing_Rapport_on_Mac.html
https://www.ibm.com/support/knowledgecenter/SS7MJT_1930/ug/t_Installing_Rapport_on_Mac.html
https://www.ibm.com/support/knowledgecenter/SS7MJT_1930/ug/c_Installing_Rapport.html
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Note: The two bullet points on the Enable extension dialog are generic Chrome information. 
Rapport has not changed other than requiring an extension to provide browser protection. 

If Chrome was open during the Rapport installation, please restart it. The Chrome extension is 
now enabled and the end user can navigate to the online banking site with full Rapport 
protection. 

2. If you do not see the message, click the orange Chrome menu, and then click New extension 
added (IBM Security Rapport). 

The Enable extension dialog appears and the end user can click Enable extension. 

Troubleshooting 

What Happens if the Extension is Disabled? 

If the end user does not enable the extension, the following occurs when they try and navigate to the 
online banking site: 

 If you are Mandatory Rapport customer, end users will only be allowed to access your online 
banking site if the Rapport extension is enabled. If it is disabled, they will receive the splash 
screen. 

 Non-mandatory users will be able to access the online banking site, but with limited 
protection, i.e. general computer protection is active, but browser level protection is not. 
Users may see the splash screen depending on your configuration. 

Note: The protection status can always be determined by the Rapport icon. If it is green, it is 
providing protection. If it is gray, it is enabled, but the user is not on a protected site. 
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How to Enable the Extension 

If the end user did not click Enable extension when installing Rapport, or the extension is disabled, 
the extension can be enabled at any time with the following procedure. 

1. Open Chrome. 

2. Click the menu button, click More tools, and then click Extensions. 

The Extensions screen appears. 

3. Select the Enable check box. 

 

The Rapport Chrome extension is now enabled. The end user will see the gray Rapport icon in the 
toolbar: 

 
The Rapport icon is colored green when navigating to your banking site to indicate that the site is 
protected. The end user can go to the banking site to make sure that it works. 
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The Extension was Removed: Mac 

If the end user clicked Remove from Chrome when prompted to enable the extension, or if the end 
user removed the extension and needs to reinstall it, do the following: 

1. Open the IBM Trusteer Rapport Console by clicking the Apple menu > System Preferences > 
Trusteer Endpoint Protection. 

2. In the Product Settings area, click Install Chrome Extension. 
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Note: If Google Chrome is not set as your default browser, the link will open in whichever 
browser is set as default. Copy the URL from the address bar and paste it into a Chrome browser 
to continue. 

3. You will be directed to the Google Chrome web store; Click Add to Chrome to add the 
extension to your browser. 

 
4. When prompted, click Add extension. 

 

Note: The two bullet points on the Add extension dialog are generic Chrome information. 
Rapport has not changed other than requiring an extension to provide browser protection. 
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The Extension was Removed: Windows 

If the end user clicked Remove from Chrome when prompted to enable the extension, or if the end 
user removed the extension and needs to reinstall it, do the following: 

1. Open the IBM Security Trusteer Rapport Console by clicking Start > All Programs > Trusteer 
Endpoint Protection > Trusteer Endpoint Protection Console. 

2. In the Product Settings area, next to Chrome extension, click install chrome extension. 

 

Note: If Google Chrome is not set as your default browser, the link will open in whichever 
browser is set as default. Copy the URL from the address bar and paste it into a Chrome browser 
to continue. 
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3. You will be directed to the Google Chrome web store; Click Add to Chrome to add the 
extension to your browser. 

 
4. When prompted, click Add extension. 

 

Note: The two bullet points on the Add extension dialog are generic Chrome information. 
Rapport has not changed other than requiring an extension to provide browser protection. 
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Mozilla Firefox Extension 

Information for Existing Rapport Users  

Users that already have Rapport installed do not need to reinstall it. 

However, they need to enable the extension the next time that they start Firefox. Users who already 
enabled the extension from a previous Rapport version are not required to do anything. 

As with past releases, it is highly recommended to install Rapport from an administrator account, 
since it automatically extends Rapport protection to all users. 

How do I Install the Extension? 

Rapport must be installed before you can use the Rapport extension. For more information about 
installing Rapport on Mac and Windows, see: 

 Mac: 
https://www.ibm.com/support/knowledgecenter/SS7MJT_1930/ug/t_Installing_Rapport_on_Ma
c.html 

 Windows: 
https://www.ibm.com/support/knowledgecenter/SS7MJT_1930/ug/c_Installing_Rapport.html 

To help you better understand how to use the new Rapport extension we created several videos on 
the following page: https://www.trusteer.com/support/firefox-extension 

The extension will be automatically installed as part of the Rapport installation. After Rapport 
installation, the next time end users start Firefox, they need to do the following: 

1. The end user must click the menu button, and then click IBM Security Rapport added to 
Firefox. 

https://www.ibm.com/support/knowledgecenter/SS7MJT_1930/ug/t_Installing_Rapport_on_Mac.html
https://www.ibm.com/support/knowledgecenter/SS7MJT_1930/ug/t_Installing_Rapport_on_Mac.html
https://www.ibm.com/support/knowledgecenter/SS7MJT_1930/ug/c_Installing_Rapport.html
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2. The Add-ons Manager opens and on the enable extensions dialog, click Enable. 

 
If Firefox was open during the Rapport installation, please restart it. The Firefox extension is now 
enabled and the end user can navigate to the online banking site with full Rapport protection. 
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Troubleshooting 

What Happens if the Extension is Disabled? 

If the end user does not enable the extension, the following occurs when they try and navigate to the 
online banking site: 

 If you are Mandatory Rapport customer, end users will only be allowed to access your online 
banking site if the Firefox extension is enabled. If it is disabled, they will receive the splash 
screen. 

 Non-mandatory users will be able to access the online banking site, but with limited 
protection, i.e. general computer protection is active, but browser level protection is not. 
Users may see the splash screen depending on your configuration. 

Note: The protection status can always be determined by the Rapport icon. If it is green, it is 
providing protection. If it is gray, it is enabled, but the user is not on a protected site. 

In addition, if the extension is disabled, you might see the following Rapport message: 

 
Click OK and follow the instructions above to enable the extension. 
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How to Enable the Extension 

If the end user did not click Enable when installing Rapport, or the extension is disabled, the 
extension can be enabled at any time with the following procedure. 

1. Open Firefox. 

2. Click the menu button and select Add-ons. 

3. Click Extensions. 

The Extensions screen appears. 

 
4. Click Enable. 

The Rapport Firefox extension is now enabled. The end user will see the gray Rapport icon in the 
address bar: 
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The Rapport icon is colored green when navigating to your banking site to indicate that the site is 
protected. The end user can go to the banking site to make sure that it works. 
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